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Webinar date – 26th March 2025
Screenshots in this session and links to materials may become outdated over time. 

Local Authorities are advised to always check DfE guidance for themselves and 
should not rely solely on information provided in this session (which is always 
subject to change by the DfE)



Webinar 
arrangements

• Please remain muted unless you have something to 
contribute

• When presenting unable to to see ‘hands up’ or chat

• Because this is recording for later viewing, I prefer to 
keep going through the content where possible

• NCER colleagues are available to answer questions in 
chat as we go

• Slides and the video are intended to be session notes 
and will be shared shortly after the event

• Some slides feature links to NCER help content / DfE

• We have more questions than we can answer. Please 
leave any questions you have in chat at the end, and 
we will respond in writing via the help center article 
that will hold the video



Webinar 
arrangements

• Much of this material repeats from 2024’s session 
and is also available as a video from that year.

• Some elements refer to additional functionality 
purchased from Angel Solutions (Broadcast/plus). This 
is clearly marked but is used by a high number of LA 
so worth including here

• Your LA may not choose to make use of all 
functionality available and covered here – that is for 
every LA to decide



What we will 
cover

• Key attainment data systems

• What to do in advance of assessments

• System administration tasks

• Assessment & Imports tasks

• Contextual data to load

• What to prepare for during/after assessments

• Advice for your schools



Key systems access required within LA teams

• Main delivery route for EYFS and Phonics submissions from schools

School to School (part of DfE Sign In)

• Allows LA to check whether schools have submitted KS2 writing TA (and 
download what they have uploaded) and to download the KS2 July results file

Primary Assessment Gateway

• Aside from other uses, also the route through which pupil premium and KS2 
results files (after July) are now delivered which will need to be loaded into 
Nexus

Get Information About Pupils (part of DfE Sign In)

• Apart from its many other uses, the platform through which you will load, 
process and QA EYFS and Phonics files from schools. Ensure Import permissions 
and system admin permissions are in place

Nexus

• For submission of the final files to the DfE

Collect (part of DfE Sign In)



Nexus System 
Admin tasks

• Ensure all necessary users have Nexus accounts with appropriate 
permissions (note no major changes in this area since 2024)

• Close leavers accounts (or amend permissions for users no longer 
involved but still requiring access for other reasons)

• Check users do not have TOO MANY permissions

• Update schools' area to ensure list is correct (typically around 
sponsored academies/new free schools)

• School name changes

• Check the status of old/new schools for sponsored academies if 
necessary (not required for converter academies but URN may 
change for those – this allows you to ensure everything is up and 
running ahead of importing data in terms of school access)

• New functionality will link the Head to GIAS (but new heads may 
need PL accounts)

• Ask sponsored academy heads if they require access to the old 
school in PL (Angel can arrange)

Link to System Admin checklist
Link to Finding & Maintaining school records in Nexus help centre article and video

https://ncer.zendesk.com/hc/en-gb/articles/4407635159697-System-Administration-Checklist-for-Nexus
https://ncer.zendesk.com/hc/en-gb/articles/4422715517073-Finding-and-maintaining-school-records-in-Nexus




Nexus System 
Admin tasks

• Maintain school groups in Nexus (if used) – available to select in 
Insight (within the LA)

• Standard groups – where you manually assign members who 
remain in group until you remove them

• Dynamic groups – where you update TAGs, RAG rating, 
Categories, Target grades etc. (which have their own uses) – more 
on this below – membership of groups will update as changes are 
made by any authorised user

• Examples of groups

• Geographical / Wards / MAT groups / Academies / LA / Traded 
Service – ANY group of schools useful in your LA

• You can also use groups to hold old and new identities of schools 
to run trend reports across two identities of a school. The group 
line will be the results trend

Link to School groups for reporting and analysis help centre article and 
video

https://ncer.zendesk.com/hc/en-gb/articles/4412968723857-School-groups-for-reporting-and-analysis
https://ncer.zendesk.com/hc/en-gb/articles/4412968723857-School-groups-for-reporting-and-analysis


Dynamic Groups

Standard Groups



Nexus System 
Admin tasks

• Maintain and update any of the following that are in use in your LA 
(all of which can be used in reporting and/or be used for dynamic 
groups set up)

• TAGS – for example if a new head, in Traded Service or anything 
else

• RAG ratings

• Categories
• Target grades

• Your LA may have been using some of these for simple info 
recording (rather than holding separately in spreadsheets)

• Recording may or may not be current (you might ask Angel to clear 
old data in bulk)

• You can also customize colours for RAG ratings





Nexus System 
Admin tasks

• Manage Perspective Services (if PL in use)

• Controls access to LA Services area in PL
• Update the ‘Insight Access’ for each year & area (ensure that you 

check when the new year is available to update)

• Check and update LA defaults if necessary

• Check and maintain school specific permissions (may be based on 
traded service or SLA sign up)

• Assign correct permissions to new schools like new sponsored 
academies or free schools (especially if your LA default is ‘Off’)

• If you define permissions based on sign up to traded service, 
ensure that anyone who can change those permissions is aware 
of the sign-up status of each school so only signed-up schools are 
given access and it’s not just added by accident

Link to Perspective Integrated Services help centre article

https://ncer.zendesk.com/hc/en-gb/articles/360031145992-Perspective-Integrated-Services




Nexus System 
Admin tasks

• Nova Menu > Admin
• Data settings - specify tabs available in Realtime data trends/data 

tabs (and which datasets at KS2 and KS4)

• Preferences - for each key stage what - if any - footer should be 
included at the bottom of a Nova report (may be updated later when 
data is available) 

• Insight Menu > Settings

• Manage table templates – rollover any Insight Table Templates 
(or remove if no longer required) 

• Nova Menu > Batch reports

• Create or rollover batch reports 
• Enabled once system is rolled over in May





Nexus System 
Admin tasks

• Broadcast Menu > LA View (LA who pay for this option only)

• Maintain and update folder structures used for publication of 
batch reporting and other files

• Some structures are created by selections made in batch 
reporting

• Changes may not be required – check and ensure still fit for 
purpose

• (LA who have Broadcast plus only) Broadcast Menu > Files from 
Schools 

• Set up file requests and hold them in draft until ready to launch

• More details from Angel Solutions

• Gillian will be giving a five-minute overview of this functionality 
at the end of the session for those who wish to remain. 





Non-Nexus 
prep that can 
be helpful

• Ensure all teams interacting with schools have the latest, accurate 
contact details for schools including:

• School name

• DFE Number *

• URN *

• School type (Primary, Infant, Junior etc.)

• Phone number

• Key contact email address

• Key contact name (if any)
• Escalation contact details (in LA) if school fails to respond/submit

• Much of the above is in Nexus but is quicker to access on a list 
when dealing with hundred+ schools during peak system usage

• Information on what submissions are expected from each school 
(e.g., no statutory submissions (EYFSP/Phonics) are required from a 
Junior School)

• Space for whether that has been received, processed and finalised

* Very recent opening of sponsored / converter academies may 
benefit from having both old and new numbers



Non-Nexus 
prep that can 
be helpful

• If you allow schools access to Perspective Lite you are 
recommended to ensure that they know:

• How fast you expect to load their results into the system when 
submitted (working days)

• When they can access reporting based on that submission

• Or you may have deliberately turned off reporting and analysis 
until you are ready to release it to all schools and need to give an 
indication when that will be (either dates or % national 
completeness)

• Caveats around completeness of LA, regional and emerging 
national comparisons

Immediate update Overnight update

Nova reports / Reports (Nova) Real-time data trends

Insight / Analysis (Insight)



Contextual 
data to load

• Already available

Autumn census

• Already available – Critical for 2025 attainment analysis

Spring census

• Available by July (not essential to Assessment reporting if 
delayed) 

Summer census

• Available by 27th June (deadline to submit to DfE) from CSC

SSDA903 – Children Looked After census

• Available by 31st July (deadline to submit to DfE) from CSC

CIN (Children in Need) Census

• 25/26 FY pupil premium file – likely to be available in April 2025

Pupil premium

• Can only be loaded alongside imported assessment data (Nova)

User Defined Fields (LA reporting optional)

Link to Assessments & Imports 
checklist

https://ncer.zendesk.com/hc/en-gb/articles/4407635220625-Assessments-Imports-Checklist
https://ncer.zendesk.com/hc/en-gb/articles/4407635220625-Assessments-Imports-Checklist


Contextual 
data to load

• Why load multiple years of contextual data (if not already done?)

• Enables trend reporting filters

• Supports year on year comparisons

• Supports cohort analysis, school census analysis, CIN and CLA 
cohort analysis

• Completes the population of Nexus and future-proofs further 
developments introduced to the system

• Supports whole NCER community in accessing early national 
comparative data

• HINT – make sure your social care data team are aware that you 
will need the CIN and SSDA903 files. After a few months DFE 
close the blade and you can no longer download them. 



Expected 
cohort sizes

• Nexus can help you check whether you are receiving too many / 
too few pupil results records

• To do so, you need to import the expected cohort sizes

• EYFSP and Year One Phonics can be derived from the January 
census. 

• You should expect SOME changes as pupils join and leave school

• Year Two Phonics is usually based on DfE releasing those numbers 
to LA to load in (quite often inaccurate though)

• Keypas > Imports > Import New File > Expected Cohort Sizes

• A template file is included on the import wizard page

Link to Expected Cohort Sizes help centre article

https://ncer.zendesk.com/hc/en-gb/articles/360028294292-Expected-Cohort-Sizes




Summer Primary 
Assessments – 
LA deadlines 
2025

• School deadline to STA (or LA for some) – 27th June (cannot be 
required earlier than 19th June at noon)

• LA deadline if submitting to DfE – 27th June

KS2 Teacher Assessment – Writing (Optional for 
LA)

• School deadline to LA – 30th June

• LA deadline to DfE – 31st July

EYFSP

• School deadline to LA – 18th July

• LA deadline to DfE – 18th July

Phonics

Link to 2024-25 Primary 
Assessment Timeline

https://ncer.zendesk.com/hc/en-gb/articles/360040686512-2023-24-Academic-Year-Timeline
https://ncer.zendesk.com/hc/en-gb/articles/360040686512-2023-24-Academic-Year-Timeline


Data teams - 
Early 
Submission

• LA cannot require schools to submit KS2 writing TA (if collecting 
it) before midday 19th June

• However, LA can encourage schools to submit as early as 
possible (if their assessments are complete)

• By spreading submissions out all schools are more likely to 
receive a thorough service in terms of Q&A with more time to 
resubmit

• Where moderation is a factor (KS2) this arrangement allows last 
few days to support moderated schools if others submit earlier 
(only applies where LA is collecting and submitting on behalf of 
schools)

• Helps mitigate for very late submissions due to moderation

• Depends on relationships with schools and not for every LA. 
Cannot just be decided in data teams. Speak to your KS2 
Moderation Manager if you’re an LA who does this

• If you have the resources to cope – no need to do this

• Need to very clear that this is not a requirement if used



Data teams - 
Other items…

• LA have visibility of whether their schools had submitted KS2 
Writing TA through PAG. LA may wish to consider checking and 
reminding schools who have not submitted by deadline day 
(possibly as part of SLA/Traded Service offer)

• The Phonics, KS2 ARA / EYFSP Handbook and other guidance 
docs contain the answers to most questions posed and are 
available for everyone to check

• Sign up to STA notifications around document publication - STA 
mailing lists seem inconsistent and unreliable – do your own 
research in case you were not notified

• Statutory assessment generally requires a Headteachers 
Declaration Form per assessment - failure to submit is an 
indication of maladministration. Maybe remind your schools 
about this requirement – especially new heads – but it is their 
responsibility, and you cannot monitor whether they have 
complied

Links to DfE documentation (e.g. ARA)

https://ncer.zendesk.com/hc/en-gb/articles/4409842068881-Links-to-DfE-Documentation


Important 
point for LA 
data teams

• Results submitted by the school via the LA are the responsibility 
of the school and specifically the Head

• LA should have a clear audit trail if asked to to change the 
results for the school and send those on to DFE

• Ideally get the school to make the change and resubmit the 
whole file to you but you do have the option in the system to 
make changes or re-upload single pupils

• Otherwise, how can the Head sign off their submission on the 
Head Teachers Declaration Form if the LA has changed the file 
they submitted?

• If imminent statutory deadlines or practicality mean you must 
make a change for the school, stress to the school that they 
MUST make the same changes in their records, and you should 
keep an email to the school (and Head) confirming exactly what 
you have done (in case of any maladministration investigation as 
these can be extremely serious). 

• Potentially send the school a QA file to approve after changes 
are made



After loading 
2025 LA 
submissions

• Quality assurance

• Part of the reason schools submit via the LA is for the LA to 
quality assure their submission (a part of the LA statutory duty to 
submit)

• This occurs within Nexus and is the basis of primary early data in 
the system for EYFSP and Phonics

• Keypas > Tree View > Assessment Name > Data Cleaning

• Since 2024 a single data cleaning report will cover multiple areas 
rather than separate reports. For example:

• Duplicate UPN / Incorrect UPN Length / Missing or Temp UPN

• DOB issues

• Illegal characters in names etc.

• Report per Key Stage
• Expected cohort sizes also available if loaded

• Additional report to fix errors

• Documentation will be updated once released
Link to Navigating Around Tree View 
help centre article

https://ncer.zendesk.com/hc/en-gb/articles/360028778831-Navigating-Around-Tree-View
https://ncer.zendesk.com/hc/en-gb/articles/360028778831-Navigating-Around-Tree-View




After loading 
2025 LA 
submissions

• Keypas > DfE Returns

• The LA has a statutory duty to submit files to DfE on behalf of their 
schools for:

• EYFSP

• Phonics

• Once the file has been checked for errors and any necessary 
resubmissions made you will need to export

• Some LA also have agreements to submit KS2 Writing TA on behalf 
of schools (not required, this is only a local agreement but if the LA 
takes this responsibility on then it must be completed)

• Returns are generated via Keypas > DfE Returns

Link to DfE Returns help centre article

https://ncer.zendesk.com/hc/en-gb/articles/4421117026449-DfE-Returns




After loading 
2025 LA 
submissions

• KS2 Results (Keypas > Imports > Import New File > KS2 DFE)

• Contains the key accountability data for most primary phase 
schools and is the element they are generally most interested in

• Due for release on 8th July

• Possible that DfE will deliver a file with a different file 
specification to that expected

• Check forums to see if there are any reported issues/confirmed 
loading by other LA

• If you are the first LA, please report any failure to load to Angel 
Solutions

• Angel have generally responded to this challenge within a few 
hours in previous years

• Please load in the file as soon as possible once you can - for the 
benefit of the whole membership community and your 
schools/LA users

Link to Importing Results into Keypas help 
centre article and video

https://ncer.zendesk.com/hc/en-gb/articles/360055754912-Importing-results-into-Keypas
https://ncer.zendesk.com/hc/en-gb/articles/360055754912-Importing-results-into-Keypas


After loading 
2025 LA 
submissions

• News > Manage Perspective News

• Not every LA may opt to use this facility as a comms channel to 
school but useful for those who do…

• Still useful to have reference in system to key messages you want 
schools to be aware of such as:

• Updates on the completeness of emerging national 
comparisons and confidence in those figures stabilising

• Text or links to guidance or external documents such as DfE 
commentary about results

• Updates about what batch reports you’ve published (if your LA 
does) and when more can be expected

• Anything you want schools to be able to refer to later

• Confirm when KS2 results received and loaded

• News can be published to all schools or subsets of schools –
generally for primary assessments limit to primary schools



Reporting 
and Analysis 
in 2025

• Remember that Insight updates overnight

• Nova and batch reporting can be used as soon as data is submitted

• Wouldn’t recommend batch reporting until submissions complete 
and loaded (though you may choose to do so)

• Nova reports may be useful for checking data and/or moderation 
data checking (pupil lists and school summary reports)

• If your aim is to release reporting before school’s break up AND you 
use batch reporting, you may also want to refresh batches over the 
summer for completeness as changes are made in other LA and –
for KS2 only – once again after release of DFE unvalidated data in 
September.  

• Remember that there will – again – be no KS1 to KS2 progress 
measure in 2025 (due to the pandemic)



Multiplication 
Table Check

• Nexus can import Year 4 MTC

• If you have not yet asked your schools whether they would 
wish to submit this data (as provided to them by DfE) for 
loading, suggest you may wish to do so

• School and LA reporting will be (largely) complete if you 
get good buy in. Emerging national numbers will depend 
on offerings across LA

• Don’t wait and see what others do and what the national 
take up is – if everyone does that, it will obviously be low

• NPD data for 2025 will not be available for several months



KS1 2025

• Key Stage 1 became non-statutory after 2023

• DfE encourage schools to continue to administer tests (bank of old 
papers) and make TA judgements internally

• Nexus can still load in KS1 results from those schools who wish to 
submit it to the LA

• If your schools wish to submit then the school will get their 
reporting and the LA gets a picture of performance. 

• Completeness of the national picture an open question but the 
more schools and LA do so the more complete it will be

• OPTIONAL – cannot force a school to take part. 
• NOTHING goes to DfE – just for schools and LA benefit



KS1 collection 
benefits

• KS1 is a valuable progression check-in for pupils between Baseline 
and KS2, a gap of 7 years

• NCER can offer robust national, regional and local authority 
benchmarking within days (not months) of supplying assessments 
to the LAs if we get the LA and school buy-in

• Schools can do their own slicing and dicing and analysis using the 
LA tools (Nova, Insight) if they have nuanced segments they wish to 
focus upon.

• LAs can, if they wish, use this as a revenue generation scheme 
(especially with academies) via the provision of services or 
analytics

• Everything is already in place, ready to go - we just need the data 
and they can easily be produced via the schools MISs (like they 
have been able to for years).

• In a few years' time we’ll again be able to offer a KS1 to KS2 
progress measure (even though there won't be an official one).



2025 NCER 
supporting 
materials 
(links)

Links
to
key Links to key DfE documentation

Assessment
 
ImportsAssessment  Imports checklist

System
Admin
checklistSystem Admin checklist

Understanding
NCER
Early Understanding NCER Early  Emerging National Data

2024/25
Academic
Year 2024/25 Academic Year Timeline

Guides
to
EYFSP,Guides to EYFSP, Phonics, KS2Keypas Import Guidesassessments

School
census

School census

CLA
and
CIN CLA and CIN census data

Pupil
Premium
data Pupil Premium data

• Development of supporting materials is always a work in progress

• Already available:
• Links to key DfE documentation

• Assessment & Imports checklist

• System Admin checklist

• Understanding NCER Early & Emerging National Data

• 2024/25 Academic Year Timeline

• Guides to EYFSP, Phonics, KS2

• Updated Keypas Import Guides

• Including assessments

• School census

• CLA and CIN census data

• Pupil Premium data

• And more…

https://ncer.zendesk.com/hc/en-gb/articles/4409842068881-Links-to-DfE-Documentation
https://ncer.zendesk.com/hc/en-gb/articles/4409842068881-Links-to-DfE-Documentation
https://ncer.zendesk.com/hc/en-gb/articles/4407635220625-Assessments-Imports-Checklist
https://ncer.zendesk.com/hc/en-gb/articles/4407635220625-Assessments-Imports-Checklist
https://ncer.zendesk.com/hc/en-gb/articles/4407635159697-System-Administration-Checklist-for-Nexus
https://ncer.zendesk.com/hc/en-gb/articles/4407635159697-System-Administration-Checklist-for-Nexus
https://ncer.zendesk.com/hc/en-gb/articles/4405303209617-NCER-Early-Emerging-National-Data
https://ncer.zendesk.com/hc/en-gb/articles/4405303209617-NCER-Early-Emerging-National-Data
https://ncer.zendesk.com/hc/en-gb/articles/360040686512-2021-22-Academic-Year-Timeline
https://ncer.zendesk.com/hc/en-gb/articles/360040686512-2021-22-Academic-Year-Timeline
https://ncer.zendesk.com/hc/en-gb/sections/360004534812-Fact-Sheets-Timelines
https://ncer.zendesk.com/hc/en-gb/sections/360004534812-Fact-Sheets-Timelines
https://ncer.zendesk.com/hc/en-gb/sections/360004572251-Keypas-Import-Quick-Guides
https://ncer.zendesk.com/hc/en-gb/articles/360055754912
https://ncer.zendesk.com/hc/en-gb/articles/360028398371
https://ncer.zendesk.com/hc/en-gb/articles/360028398371
https://ncer.zendesk.com/hc/en-gb/articles/360028591491
https://ncer.zendesk.com/hc/en-gb/articles/360028591491
https://ncer.zendesk.com/hc/en-gb/sections/360005987432-Pupil-Premium
https://ncer.zendesk.com/hc/en-gb/sections/360005987432-Pupil-Premium
https://ncer.zendesk.com/hc/en-gb/articles/4409842068881-Links-to-DfE-Documentation
https://ncer.zendesk.com/hc/en-gb/articles/4407635220625-Assessments-Imports-Checklist
https://ncer.zendesk.com/hc/en-gb/articles/4407635159697-System-Administration-Checklist-for-Nexus
https://ncer.zendesk.com/hc/en-gb/articles/4405303209617-NCER-Early-Emerging-National-Data
https://ncer.zendesk.com/hc/en-gb/articles/360040686512-2021-22-Academic-Year-Timeline
https://ncer.zendesk.com/hc/en-gb/sections/360004534812-Fact-Sheets-Timelines
https://ncer.zendesk.com/hc/en-gb/sections/360004572251-Keypas-Import-Quick-Guides
https://ncer.zendesk.com/hc/en-gb/articles/360055754912
https://ncer.zendesk.com/hc/en-gb/articles/360028398371
https://ncer.zendesk.com/hc/en-gb/articles/360028591491
https://ncer.zendesk.com/hc/en-gb/sections/360005987432-Pupil-Premium


Upcoming 
support

https://ncer.zendesk.com/hc/en-gb/articles/21886239291421-Perspective-Lite-LA-Services-Introductory-Videos

https://ncer.zendesk.com/hc/en-gb/articles/21886239291421-Perspective-Lite-LA-Services-Introductory-Videos

https://ncer.zendesk.com/hc/en-gb/articles/21886239291421-Perspective-Lite-LA-Services-Introductory-Videos

paul.caladine@kirklees.gov.uk

• Updated documentation and videos being released over the year as 
part of help centre articles

• Ongoing update of help centre guides and videos (including some 
referenced in this video needing update following deployments of new 
functionality)

• Videos to help demonstrate the LA Services menu options in 
Perspective Lite to schools are available via the following link: 
https://ncer.zendesk.com/hc/en-gb/articles/21886239291421-
Perspective-Lite-LA-Services-Introductory-Videos

• Any LA with significant concerns around the processes, please let me 
know

• Contact details: paul.caladine@kirklees.gov.uk

https://ncer.zendesk.com/hc/en-gb/articles/21886239291421-Perspective-Lite-LA-Services-Introductory-Videos
https://ncer.zendesk.com/hc/en-gb/articles/21886239291421-Perspective-Lite-LA-Services-Introductory-Videos
https://ncer.zendesk.com/hc/en-gb/articles/21886239291421-Perspective-Lite-LA-Services-Introductory-Videos
mailto:paul.caladine@kirklees.gov.uk
https://ncer.zendesk.com/hc/en-gb/articles/21886239291421-Perspective-Lite-LA-Services-Introductory-Videos
https://ncer.zendesk.com/hc/en-gb/articles/21886239291421-Perspective-Lite-LA-Services-Introductory-Videos
mailto:paul.caladine@kirklees.gov.uk


Q&A Session

• Post meeting Q&A session immediately after Annual Meeting

• NCER Board members and Angel Solutions colleagues will support 
with any questions that you have and we will come back to any 
questions we don’t have time to answer and publish a response

• Try and start to look at the tasks recommended for your LA by that 
point if you’re unfamiliar



As a reminder Gillian from Angel is holding a five-
minute session after the Q&A opportunity – covering 

the paid for Broadcast functionality that can help with 
submissions from schools. 



Thank you for your time and participation

Today's slides are already on the Nexus Help Centre 
Nexus Videos > Webinars > Webinar – Preparing for 

primary assessment 24/25 – 26th March 2025

Any remaining / useful Q&A from chat will be 
uploaded as soon as possible to the same page

The video will follow within 7 days





5 Reasons For LAs To Use File Requests

1. Used by 53 local authorities

2. Streamline collection process 
with automation

3. File validation and rejection 
handling

4. Add optional file prefixes to 
downloaded files

5. Save £000s on separate 3rd 
party systems



5 Reasons For Schools To Love File Requests

1. Return files from existing 
Perspective accounts

2. Complete audit trail between 
school and LA

3. Transparent reasons for 
rejection workflow

4. Seamless multi-file upload

5. Add contextual comments to 
any file return 



Gillian Heath

E: gillian.heath@angelsolutions.co.uk

T: 0151 541 4028

W: angelsolutions.co.uk/broadcast

Upcoming Webinar:

Come and see all the features that are 

helping LAs to save time and reduce 

workload in relation to sending and 

receiving files with schools

11am, 31st March 2025

Scan QR code to book your place:

Speak to us today about how Broadcast can make your 2025 data collection a walk in the park.

We’re ready and waiting to get you up and running in no time.

mailto:gillian.heath@angelsolutions.co.uk
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